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Where to Find Information
Setup Guide

This guide will help you set up and begin using your printer. It 
includes information on setting up your printer and installing the 
printer software.

Daily Use guide

This guide provides information on normal printer operation. It 
also contains troubleshooting tips and customer support 
information.

Reference Guide included on the CD-ROM

The Reference Guide contained on the CD-ROM included with 
your printer provides detailed information about printer software 
settings, printing on special paper, maintenance, and problem 
solving.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, mechanical, photocopying, 
recording, or otherwise, without the prior written permission of SEIKO EPSON 
CORPORATION. The information contained herein is designed only for use with this EPSON 
printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of 
this product or third parties for damages, losses, costs, or expenses incurred by the purchaser 
or third parties as a result of: accident, misuse, or abuse of this product or unauthorized 
modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly 
comply with SEIKO EPSON CORPORATION's operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from 
the use of any options or any consumable products other than those designated as Original 
EPSON Products or EPSON Approved Products by SEIKO EPSON CORPORATION.

SEIKO EPSON CORPORATION shall not be held liable for any damage resulting from 
electromagnetic interference that occurs from the use of any interface cables other than those 
designated as EPSON Approved Products by SEIKO EPSON CORPORATION.

EPSON is a registered trademark and EPSON Stylus is a trademark of SEIKO EPSON 
CORPORATION.

Microsoft and Windows are registered trademarks of Microsoft Corporation.

General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

Copyright © 2000 by SEIKO EPSON CORPORATION, Nagano, Japan.
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Safety Instructions

Important Safety Instructions
Read all of these instructions before using your printer. Also, be 
sure to follow all warnings and instructions marked on the 
printer.

❏ Do not block or cover the openings in the printer’s case. Do 
not insert objects through the slots.

❏ Take care not to spill liquid on the printer.

❏ Use only the type of power source indicated on the printer’s 
label.

❏ Connect all equipment to properly grounded power outlets. 
Avoid using outlets on the same circuit as photocopiers or air 
control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or 
automatic timers.

❏ Keep the entire computer system away from potential sources 
of electromagnetic interference, such as loudspeakers or the 
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure that 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. Also, 
make sure that the total ampere rating of all devices plugged 
into the wall outlet does not exceed the wall outlet’s ampere 
rating.

❏ Do not attempt to service the printer yourself.

❏ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions:
 3
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The power cord or plug is damaged; liquid has entered the 
printer; the printer has been dropped or the case damaged; 
the printer does not operate normally or exhibits a distinct 
change in performance.

❏ If you plan to use the printer in Germany, the building 
installation must be protected by a 10 or 16 amp circuit 
breaker to provide adequate short-circuit protection and 
over-current protection for this printer.

A Few Precautions
Take note of the following when using the printer, handling the 
ink cartridges, or choosing a location for the printer.

When using the printer
Observe the following:

❏ Do not put your hand inside the printer or touch the ink 
cartridges during printing.

❏ Do not move the print head by hand; otherwise, you may 
damage the printer.

❏ Remove your printouts from the output tray shortly after 
printing ; otherwise, the output tray may wrap.

❏ Always turn the printer off using the � power button. When 
this button is pressed, the � power light flashes briefly and 
then goes out. Do not unplug the printer or turn off the power 
to the outlet until the � power light stops flashing.

❏ Before transporting the printer, make sure that the print head 
is in the home (far right) position and the ink cartridges are 
in place.
4
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When handling the ink cartridges
Observe the following:

❏ Keep ink cartridges out of the reach of children. Do not allow 
children to drink from or otherwise handle the cartridges.

❏ Be careful when you handle the used ink cartridges, as there 
may be some ink remaining around the ink supply port. If ink 
gets on your skin, wash the area thoroughly with soap and 
water. If discomfort or vision problems remain after a 
thorough flushing, see a doctor immediately.

❏ Do not shake an ink cartridge; this can cause leakage.

❏ Install the ink cartridge immediately after you remove it from 
its package. Leaving the cartridge unpacked for a long time 
before use may result in reduced print quality.

❏ Do not use an ink cartridge beyond the date printed on the 
cartridge carton. For best results, use up the ink cartridges 
within six months of installing them.

❏ Do not dismantle the ink cartridges or try to refill them. This 
could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site, 
allow it to warm up at room temperature for at least three 
hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Do not touch the green IC chip on the side of the cartridge. 
This may affect normal operation and printing.

❏ In this ink cartridge, the IC chip retains a variety of cartridge 
related-information, such as the amount of ink remaining, so 
that a cartridge may be removed and reinserted freely. 
However, each time the cartridge is inserted, some ink is 
consumed because the printer automatically performs a 
reliability check.
 5
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❏ If you remove an ink cartridge for later use, protect the ink 
supply area from dirt and dust and store it in the same 
environment as the printer. Note that there is a valve in the 
ink supply port, making covers or plugs unnecessary, but care 
is needed to prevent the ink from staining items that the 
cartridge touches. Do not touch the ink cartridge ink supply 
port or surrounding area.

When choosing a place for the printer
Observe the following:

❏ Place the printer on a flat, stable surface that extends beyond 
the printer base in all directions. The printer will not operate 
properly if it is tilted or at an angle.

❏ Leave enough space in front of the printer for paper to be fully 
ejected.

❏ Avoid places subject to rapid changes in temperature and 
humidity. Also, keep the printer away from direct sunlight, 
strong light, or heat sources.

❏ Avoid places subject to shocks and vibrations.

❏ Avoid places subject to dust.

❏ Leave enough room around the printer to allow for sufficient 
ventilation.

❏ Place the printer near a wall outlet where the plug can be 
easily unplugged.
6
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For United Kingdom Users

Use of options
EPSON (UK) Limited shall not be liable against any damages or 
problems arising from the use of any options or consumable 
products other than those designated as Original EPSON 
Products or EPSON Approved Products by EPSON (UK) Limited.

Safety information

� Warning:
This appliance must be earthed. Refer to the rating plate for 
voltage and check that the appliance voltage corresponds to the 
supply voltage.

Important:
The wires in the mains lead fitted to this appliance are coloured 
in accordance with the following code:

Green and yellow — Earth
Blue — Neutral
Brown — Live

If you have to fit a plug:
As the colours of the mains lead of this appliance may not match 
the coloured markings used to identify the terminals in a plug, 
please proceed as follows:

The green and yellow wire must be connected to the terminal in 
the plug which is marked with the letter E or the earth symbol (�).

Green and yellow Earth

Blue Neutral

Brown Live
 7
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The blue wire must be connected to the terminal in the plug 
marked with the letter N.

The brown wire must be connected to the terminal in the plug 
marked with the letter L.

If damage occurs to the plug, replace the cord set or consult a 
qualified electrician.

Replace fuses only with a fuse of the correct size and rating.

Warnings, Cautions, and Notes

� Warnings
must be followed carefully to avoid bodily injury.

� Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of your 
printer.

Loading Special Paper, Envelopes, 
and Other Media

You can print on a wide variety of special media, including ink 
jet paper, photo quality glossy film, photo paper, transparencies, 
index cards, and adhesive sheets.

When loading special media distributed by EPSON, read the 
instruction sheets packed with the media first. For more details 
on using special media, see “Paper Handling” in the online 
Reference Guide.
8
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Loading Envelopes 
When printing on envelopes, please note the following:

❏ You can load up to 10 envelopes at a time in the sheet feeder.

Note:
The folding quality and thickness of envelopes varies widely. If the 
total thickness of the stack of envelopes exceeds 10 mm, press each 
envelope in the stack flat before loading. If print quality declines 
when a stack of envelopes is loaded, load one envelope at a time.

❏ Load envelopes flap edge first with the flap side down.

❏ Do not use envelopes that are curled or folded. Flatten the 
envelope flaps before loading. Avoid using envelopes that are 
too thin as they may curl during printing.

❏ Select Plain Paper as the Media Type setting in the printer 
driver.

Printing with Windows
The printer software which comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top operating condition.

Accessing the printer software

From Windows applications
For accessing the printer software, click Print or Print Setup from 
the File menu. In the dialog box that appears, click Printer, Setup, 
Options, or Properties. (Depending on your application, you 
may need to click a combination of these buttons.) The printer 
driver opens.
 9
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When you access the printer software from a Windows 
application, the settings that you make apply only to the 
application you are using.

From the Start menu (Windows 98, 95, 2000, and 
NT 4.0)

For accessing the printer software, click Start, point to Settings, 
then click Printers. For Windows 98 and 95 users, select your 
printer, then click Properties on the File menu. For Windows 2000 
users, select your printer, then click Printing Preferences on the 
File menu. For Windows NT 4.0 users, select your printer, then 
click Document Defaults on the File menu. The printer driver 
opens.

When you access the printer software from the Start menu, the 
settings that you make apply to all of your Windows applications.

From the Control Panel (Windows 3.1)
For accessing the printer software, double-click the Control 
Panel icon in the Main program group and double-click the 
Printer icon. Select your printer in the Installed Printer list and 
click Setup. The printer driver opens.

Making Changes to Printer Settings
The printer driver features the following menus and settings.

Note:
The Layout menu is available for Windows 98, 95, 2000, and NT 4.0 
users.

Main: Media Type, Ink, Mode, Print Preview

Paper: Paper Size, Copies, Orientation, Printable Area

Layout: Reduce/Enlarge, Multi-Page, Watermark
10
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The Mode settings on the Main menu are arranged to give you 
three levels of control over the printer driver.

In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the Paper and Layout menus. For more 
information about the Paper and Layout menus, see your online 
Reference Guide.

Making the Media Type setting
The Media Type setting determines what other settings are 
available, so you should always make this setting first. On the 
Main menu, select the Media Type setting that matches the media 
that is loaded in the printer.

Automatic When this mode is selected, the printer 
driver takes care of all detailed settings 
based on the current Media Type and Ink 
settings. To make the Ink setting, click 
Color to print in color, or Black to print in 
black-and-white or grayscale. 
Depending on the media selected in the 
Media Type list (while Automatic is 
selected), a slider appears under the 
Custom radio button that lets you choose 
from Quality or Speed settings. Select 
Quality when print quality is more 
important than speed.

PhotoEnhance This mode provides a variety of image-
correction settings that you can apply to 
your photos before printing. 
PhotoEnhance does not affect your 
original data. This mode is only available 
when printing 16-, 24-, or 32-bit color data.

Custom This mode offers ready-made settings 
designed for printing text and graphs and 
for applying a color-matching method. 
You can also create and save your own 
custom settings using the Advanced 
settings.
 11
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Previewing your printout
Select the Print Preview check box on the Main menu when you 
wish to view a preview of your document before printing.

Printing with Macintosh

Printer Software Introduction
The printer software which comes with your printer includes a 
printer driver and printer utilities. The printer driver lets you 
choose from a wide variety of settings to get the best results from 
your printer. The printer utilities help you check the printer and 
keep it in top condition.

Making Changes to Printer Settings
You will find the printer driver settings in the following dialog 
boxes.

❏ Print dialog box (click Print on the File menu of your 
application or click Options in the Page Setup dialog box)

❏ Page Setup dialog box (click Page Setup on the File menu of 
your application)

❏ The Mode settings in the Print dialog box are arranged to give 
you four levels of control over the printer driver.

In addition to making comprehensive Mode settings that affect 
overall print quality, you can also modify individual aspects of 
your printout using the settings contained in the Page Setup and 
the Layout dialog boxes.
12
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Making the Media Type setting
The Media Type setting determines what other settings are 
available, so you should always make this setting first.

In the Print dialog box, select the Media Type setting that matches 
the paper you loaded in the printer.

Previewing your printout
Click the  Preview icon button in the Print dialog box. The Print 
button changes into a Preview button. 

Replacing Ink Cartridges

Using the printer's control panel
The printer’s indicator lights will inform you when it is time to 
obtain a replacement ink cartridge and when it is time to replace 
an empty cartridge. You can also check ink levels and start the ink 
cartridge replacement procedure from your computer using the 
How to button in the Status Monitor’s Print Status window.

� Caution:
❏ EPSON recommends the use of genuine EPSON ink 

cartridges. Other products not manufactured by EPSON 
may cause damage to your printer not covered by EPSON's 
warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement; otherwise, ink remaining in the print 
head nozzles may dry out.

❏ Do not refill the ink cartridges. The printer calculates the 
amount of ink remaining using an IC chip on the ink 
cartridge. Even if the cartridge is refilled, the amount of ink 
remaining will not be recalculated by the IC chip and the 
amount of ink available for use will not change.
 13
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Note:
❏ You cannot continue printing with one ink cartridge empty, even if 

the other cartridge still contains ink. Before printing, replace the 
empty cartridge.

❏ In addition to the ink used during document printing, ink is 
consumed during the print head cleaning operation and during the 
self-cleaning cycle which is performed when the printer is turned 
on, and during ink charging when the ink cartridge is installed in 
the printer.

Maintenance

Checking the Print Head Nozzles
If you find that the printed image is unexpectedly faint or dots in 
the printed image are missing, you may be able to identify the 
problem by checking the print head nozzles.

You can check the print head nozzles from your computer using 
the Nozzle Check utility in the printer software, or from the 
printer itself by using the printer’s control panel buttons.

Using the Nozzle Check utility
Note:
Do not use the Nozzle Check utility while printing is in progress; 
otherwise, your printout may be marred.

For Windows users
Click the Utility tab in the printer software, then click the Nozzle 
Check button.

For Macintosh users
Access the Print or Page Setup dialog box and click the  Utility 
icon button, then click the Nozzle Check button in the Utility 
dialog box.
14
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Cleaning the Print Head
If you find that the printed image is unexpectedly faint or dots in 
the printed image are missing, you may be able to solve these 
problems by cleaning the print head, which ensures that the 
nozzles are delivering ink properly.

You can clean the print head from your computer using the Head 
Cleaning utility in the printer software, or from the printer itself 
by using the printer’s control panel buttons.

Note:
❏ Print head cleaning uses both color and black ink. To avoid wasting 

ink, clean the print head only if print quality declines; for example, 
if the printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head 
needs to be cleaned. This saves ink.

❏ Do not start the Head Cleaning or Nozzle Check utility while 
printing is in progress; otherwise, your printout may be marred.

Using the Head Cleaning utility
Note:
If the error light is flashing, you can not clean the print head. Replace 
the appropriate ink cartridge first.

For Windows users
Click the Utility tab in the printer software, then click the Head 
Cleaning button.

For Macintosh users
Access the printer software and click the  Utility icon button in 
the Print or Page Setup dialog box, then click the Head Cleaning 
button.
 15
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Aligning the Print Head
If you notice a misalignment of vertical lines, you may be able to 
solve this problem from your computer using the Print Head 
Alignment utility in your printer software. Refer to the 
appropriate section below.

Note:
Do not start the Print Head Alignment utility while printing is in 
progress; otherwise, your printout may be marred.

For Windows users
Click the Utility tab in the printer software, then click the Print 
Head Alignment button.

For Macintosh users
Access the printer software and click the  Utility icon button in 
the Print or Page Setup dialog box, then click the Print Head 
Alignment button.
16
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Correcting USB Problems
If you are having difficulty using your printer with a USB 
connection, read the information in this section.

Make sure that your computer is a Windows 98 
or Windows 2000 pre-installed model

Your computer must be a Windows 98 or Windows 2000 pre-
installed model. You may not be able to install or run the USB 
Printer Driver on a computer which was not originally equipped 
with a USB port or which has been upgraded from Windows 95 
to Windows 98 or 2000.

Make sure that EPSON USB Printer Devices 
appears on the Device Manager menu
(for Windows 98 only)

If you canceled the plug-and-play driver installation before the 
procedure was complete, either the USB printer device driver or 
the printer driver may be incorrectly installed.

Follow the steps below to check the installation and reinstall the 
drivers.

1. Turn the printer on. Plug the USB cable into the printer and 
the computer.

2. Right-click the My Computer icon on your desktop, then 
click Properties.

3. Click the Device Manager tab.
 17
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If your drivers are correctly installed, EPSON USB Printer 
Devices should appear on the Device Manager menu.

If EPSON USB Printer Devices does not appear on the Device 
Manager menu, click the plus (+) sign beside Other devices 
to view the installed devices. 

If USB Printer appears under Other devices , the USB printer 
device driver is not installed correctly. If EPSON Stylus 
COLOR 680 appears, the printer driver is not installed 
correctly.

If neither USB Printer nor EPSON Stylus COLOR 680 appears 
under Other devices , click Refresh or unplug the USB cable 
from the printer, then plug it into the printer again.

4. Under Other devices , select USB Printer or EPSON Stylus 
COLOR 680, and click Remove. Then, click OK.
18
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5. When the following dialog box appears, click OK. Then click 
OK to close the System Properties dialog box.

6. Turn off the printer and restart your PC. Then, reinstall the 
drivers from the beginning, following the instructions in the 
Setup Guide.

Printer does not work correctly with the USB cable
If your printer does not work correctly with the USB cable, try one 
or more of these solutions:

❏ Use the USB cable recommended.

❏ If you use a USB hub, connect the printer to the first tier of the 
hub, or connect the printer directly to the computer’s USB 
port.

❏ For Windows 98, try reinstalling the USB printer device 
driver and the printer software. First, uninstall EPSON Printer 
Software using the Add/Remove Programs utility in the 
Control Panel, then uninstall EPSON USB Printer Devices. 
Next, reinstall the software as described in Setup Guide. If 
EPSON USB Printer Devices is not registered in the 
Add/Remove Programs list, access the CD-ROM and double-
click epusbun.exe. in Win9x folder. Then follow the 
on-screen instructions.
 19
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Options and Consumable Products

Options and Consumable Products
The following options and consumable products are available for 
your printer.

Options
You can use any interface cables that meet these specifications. 
See your computer manual for any additional requirements.

❏ Parallel Interface Cable (shielded) from D-SUB 25-pin 
(computer) to 36-pin Amphenol 57 Series (printer)

❏ USB Interface Cable (shielded) from Series A4-pin (computer) 
to series B 4-pin (printer).

� Caution:
Use only interface cables which meet the specifications listed 
above.

Consumable products
The following ink cartridges and EPSON special media are 
available for your printer.

Ink cartridges
You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges may vary by location.

Black ink cartridge T017

Color ink cartridge T018
20
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Media types
EPSON offers specially-designed media for ink jet printers to 
meet most high-quality printing needs.

360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Cards (A6) S041054

EPSON Photo Quality Ink Jet Cards (5 × 8”) S041121

EPSON Photo Quality Ink Jet Cards (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheets (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 × 8” 
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10” 
(with envelopes)

S041149
 21
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Matte Paper-Heavyweight

Photo Paper

Photo Quality Glossy Film

Ink Jet Transparencies

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259

EPSON Matte Paper-Heavyweight (Letter) S041257

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064
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Premium Glossy Photo Paper

Note:
The availability of special media varies by location.

EPSON Premium Glossy Photo Paper (A4) S041287
S041297

EPSON Premium Glossy Photo Paper (Letter) S041286
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